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1 Introduction

EagleFiler makes managing your information easy. It lets you archive and search mail, Web pages,
PDF files, word processing documents, images, and more. Use it to collect information from a
variety of sources. Browse different types of files using a standard three-pane interface. Organize
them into folders and annotate them with tags and notes, or leave everything in one folder and
pin-point the information you need using the live search. Since EagleFiler stores its library in
Finder format, you can use it in concert with the other tools in your Mac ecosystem.

1.1 Importing Is a Snap

Getting your information into EagleFiler is easy. When you're viewing a Web page in Safari or
NetNewsWire!, looking at a mailbox in Mail, or browsing files in the Finder, just press the capture
key (F1 by default). EagleFiler will save the document into its library, and you can go right on
working without interrupting your flow. (Of course, you can also use drag and drop or other
methods if you prefer.) Once the document is in EagleFiler, you’ll always have a copy of the way it
looked when you imported it. No more bookmarking a great article, only to find out later that the
page is no longer available or that registration or even payment is now required. If you do research
on the Web, you know that pages change—sometimes without notice—so it’s always good to keep
a paper trail of exactly what you read. There’s no shame in being a digital pack rat when today’s
Macs ship with tens or even hundreds of gigabytes of storage.

8e6 Drop Pad

Press F1 to capture from Safari.

Library: | Sample Library e

1.2 Familiar Mail-like Interface

EagleFiler browser windows use a three-pane view that’s familiar to any Mail user. This is not a
database front-end; it’s a real Mac application with a fully Aqua user interface. Click on one or

"http://ranchero.com/netnewswire/
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more sources to view their contents. Enter some text in the search box to filter the record list.
Click on a record to view it right there in the window. HTML mail messages can be viewed as rich
text, or you can view e-mails as plain text, complete with color-coded quoted text and clickable
links. You can open as many windows as you want to view different parts of the library.
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1.3 Search Everything

It’s no good to store your information if you can’t find it when you need it. Fortunately, EagleFiler
offers some powerful search options. If you know the title, author, or recipient you’re looking for,
you can search by one of those fields. Or, use EagleFiler’s indexed search to look through the
entire contents of your documents. Like Spotlight, EagleFiler can search different types of files at
once—after all, what matters is what you’re looking for, not whether it’s in a PDF, an e-mail, or
a chat.
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Unlike Spotlight, EagleFiler makes it easy to narrow down the results. You're searching within
the library, not all the files on your hard disk, so the search is fast. You can select one or more
folders or mailboxes within the library to restrict the search—reducing the amount of data that
FagleFiler has to look through, and number of results that you’ll have to comb through. You can
even do Boolean, tag, and phrase-based searches to tell EagleFiler exactly what you’re looking
for. Once you’ve narrowed the search results to a manageable number of documents, it’s easy to
find the information you’re looking for because you can view the document contents right there in
EagleFiler.

1.4 The Library Is Open

Like iTunes and iPhoto, EagleFiler keeps your data in a library. The library is just a special folder
in the Finder that EagleFiler manages. You shouldn’t re-arrange the files and folders in the library
except through EagleFiler, but other than that you can treat it just like a regular folder. Browse
its contents in the Finder or Path Finder?—the folder structure matches the folders in EagleFiler.

BOA | . Sample Library -
10 items, 40,61 GE available
© Name & Kind -
¥ A Files Fobder
¥ [0 Mews Fobder
& Daring Fireball- ... Keys?.webarchive Wk archive
# Retum to moon ...d.com.webarchive Wb archive
B | Products Folder
[ Eil Pragrasmiming Fobder
B |0 Publicagions Fobder
| Trash Folder
B |0 Motes Folder
& Sample Library. eflibrary EsgleFiler Library

View and edit the files using your favorite applications. Drag key files to the Dock or make aliases
of them on your desktop. Search the files using Spotlight. Label files in EagleFiler, and the labels
automatically show up in the Finder—and vice-versa. Files in the library will still show up in your
applications’s Open Recent menus, and Preview will still remember which page of the PDF you
were reading. In short, you can capture, organize, and search your files using EagleFiler, without
giving up the normal conveniences of the Mac experience.

*http://wuw.cocoatech. com
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1.5 Reliable Data Storage

The library may look like just a folder full of files, but EagleFiler uses a Core Data® SQL database
to keep track of the files and their contents. This lets you put thousands of files in the library and
access them reliably and quickly. Each time you open a library, EagleFiler checks to make sure
that all the files are present. It can even verify the library (using MD5 checksums*) to make sure
that none of the files has been corrupted. There’s no point in storing and backing up damaged
files. When you archive your documents in EagleFiler, you can be sure that when you need to read
them again they’ll be in pristine condition.

06 Activity Viewer

Sample Library: Verifylng data integrity

s

About 5 seconds

Plus, EagleFiler libraries go great with backups and archival. Your data is stored in individual files,
so smart backup and synchronization programs won’t waste time and space copying the documents
that haven’t changed. Since the files are in standard formats like PDF, RTF, and mbox, you’ll be
able to read them years from now, even if—alas—you’re no longer using EagleFiler.

1.6 Add Tags and Notes

Tags are somewhat like labels in the Finder, except that each record can have as many tags as
you want. EagleFiler has some tags such as “unread,” “flagged,” and “replied” built-in, and it will
import these from Mail. If you've created additional tags in Mail using MailTags®, EagleFiler will
import those as well. You can also create your own tags. Tags may be treated like keywords, and
each tag also appears as a source in the browser window, which acts like a playlist in iTunes or an
album in iPhoto.

3http://developer.apple.com/macosx/coredata.html
‘http://en.wikipedia.org/wiki/Md5#Applications
Shttp://www.indev.ca/MailTags.html
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Each document or message in EagleFiler can also have a note. Notes are like comments in the
Finder on steroids. They support rich text with multiple fonts, sizes, and colors. Notes can even
include clickable links, graphics, tables, and lists. Use notes to write down information that goes
with your documents, to excerpt key passages, to add your own comments or analysis, or to add
links to related records in EagleFiler.

1.7 Speed Up and Simplify Your Other Applications

Most e-mail programs are designed for communicating with your mail server and letting you read
and write messages—not for storing all your old mail. By cleaning out your mail program’s
database, you can remove some clutter from its mailbox list and speed it up. But cleaning it
out doesn’t have to mean lots of time wasted trying to predict which messages you might need in
the future. Disk space is plentiful—just archive all your old mail into EagleFiler. Later, you’ll be
able to find what you need with a quick search. Meanwhile, the archived messages will no longer
be slowing down Spotlight searches of your files and current messages.

Likewise, your Web browser’s bookmarks feature is great for remembering sites that you’ll want
to go back to frequently. But it isn’t ideal for remembering the information found on Web pages.
Don’t bookmark news articles, recipes, reviews, and other documents—and then try to look through
your overflowing bookmarks folder to recall the articles by title and URL. Instead, capture the Web
pages into EagleFiler where you’ll be able to search their entire contents.

1.8 Multiple Libraries

Some people like to dump all their information into a single EagleFiler library, with minimal folder
structure, and locate documents that they need using the search feature. But EagleFiler also
supports multiple libraries, for those who like to separate their business and personal files, group
them by project or client, or keep different kinds of files in different places. For example, you might
keep some of your files on your iPod or USB keychain drive, some on an encrypted library, and
others in your Documents folder. Unlike with iPhoto and iTunes, you can have multiple EagleFiler
libraries open at once. However you want to group your files, FagleFiler can accommodate.
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2 Installing and Updating

2.1 Requirements

Mac OS X 10.4 or later is required. EagleFiler is a universal binary that runs natively on both
PowerPC- and Intel-based Macs.

It is also recommended that you install Growl® so that you get a notification each time a document
is imported into EagleFiler.

2.2 Updating From a Previous Version

The easiest way to update EagleFiler is to use the Software Update command to download and
install the latest version.

Alternatively, you can replace the old EagleFiler application file with the new one. That is, if
EagleFiler is installed in the Applications folder, drag the new EagleFiler application icon into
the Applications folder and click Replace when the Finder asks if you want to overwrite the old
version. If you get an error saying that you do not have sufficient privileges, drag the old EagleFiler
to the trash and empty it, and then drag the new one into the Applications folder.

Shttp://growl.info
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2.3 Installing EagleFiler

Double-click the EagleFiler-1.2.dmg file to mount the EagleFiler disk image. Then drag the
EagleFiler application to your Applications folder. You may need to log out and then log in
again in order for the EagleFiler commands to appear in the Services menu.

2.4 Uninstalling EagleFiler

To uninstall EagleFiler, drag its application file to the trash. Although you will no longer be able
to open your libraries with EagleFiler, the files in the libraries will remain accessible in the Finder.
Next to each library is a folder called Files (which contains the files and folders in the library)
and a folder called Notes (which contains any notes that you've added).

3 Importing

3.1 What Can Be Imported

The following types of information can be imported into EagleFiler:

e Bookmarks from Safari” and OmniWeb®, which will be downloaded and converted to Web
archives.

e Chat transcripts. iChat? logs chats as .chat or .ichat files in the folder:
/Users/<username>/Documents/iChats
Adium!® logs chats as HTML files in the folder:
/Users/<username>/Library/Application Support/Adium 2.0/Users/Default/Logs

e Dragged text from other applications. In some cases, EagleFiler will be able to import more
information if you drag the text onto one of its windows rather than its Dock icon. For
example, when dragging text from Safari, EagleFiler will be able to store URL that goes with
the text.

e Folders. EagleFiler imports the contents of the folder (and any subfolders, preserving the
hierarchy).

"http://www.apple.com/macosx/features/safari/
Shttp://www.omnigroup.com/applications/omniweb/
“http://www.apple.com/macosx/features/ichat/
Ohttp://www. adiumx . com
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e HTML files.
e Images.

e Mailboxes in mbox format and Apple Mail mailboxes, attachments included. After importing
messages into EagleFiler, you may wish to delete them from you mail client and merge them
into a previously imported mailbox with the same name.

Apple Mail

Mailboxes can be dragged directly from Mail’s mailbox list into EagleFiler. Or, select
the mailboxes and press the capture key. EagleFiler will preserve the message status
and flagged indicators from Mail, as well as any keywords, projects, and notes from
MailTags'!. The mail will be converted to standard mbox format. EagleFiler is able
to import messages from IMAP mailboxes, however it will only import the parts of the
messages that have been downloaded from the server. Thus, it is recommended that you
select the option in Mail’s preferences to keep All messages and their attachments
for offline viewing.

Entourage

Drag mailboxes directly from the mailbox list to EagleFiler. You can also drag individual
messages or exported .eml files. For especially large mailboxes, EagleFiler will be more
responsive if first you drag the mailbox from Entourage to the Finder, and then drag it
into EagleFiler.

Eudora
Mailboxes are stored in the Mail Folder folder inside the Eudora Folder folder, and
they can be dragged from the Finder into EagleFiler. They are not actually in mbox
format (for example, the attachments are removed), but the format is close enough that
EagleFiler will be able to read most of the messages.

GyazMail
Select some mailboxes and choose File > Export > Unix mbox.... Then drag the
exported files into EagleFiler.

Mailsmith

Use the capture key to import the selected mailboxes or drag the selected messages into
EagleFiler. You may find it helpful to use Email Archiver'? to separate messages by age
before importing them into EagleFiler. In Mailsmith 2.1.5, dragging mailboxes directly
to EagleFiler will not work, but you can drag mailboxes to the Finder and then drag
the exported files into EagleFiler.

PowerMail

Select some mailboxes and drag them to the Finder. Choose Unix Mailbox when it
asks you to pick a format. Then drag the exported files into EagleFiler.

Thunderbird

The mailboxes are stored in the folder:

Yhttp://www.indev.ca/MailTags . html
2http://www.garrison. com.au/freevare/emailarchiver.html
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/Users/<username>/Library/Thunderbird/Profiles/<profile>/Mail/Local Folders/

and can be dragged from the Finder to EagleFiler.
e Microsoft Word files.
e Movies.
e PDF files.
e PostScript and EPS files.
e Rich Text (RTF and RTFD) files.
e Sounds and music.
e Text files (encoded with ASCII or UTF-8, or with a byte-order-mark) and text clippings.
e URLs, which will be downloaded and converted to Web archives.
e Web archives.

e Other files. Documents that aren’t of any of the above types can also be imported into
EagleFiler, however to view their contents you will need to use the Open in External Viewer
command.

3.2 Ways to Import

There are many ways to get your files into EagleFiler. You can:

e Press the capture key.
e Drag files, text, or a URL onto:

— A EagleFiler browser window’s source list or records list.
— The Drop Pad.
— The EagleFiler application icon.

e Control-click on a file in the Finder and choose Open With > EagleFiler.

o While viewing a document in another application, choose File > Print and then choose Save
PDF to EagleFiler from the PDF button menu. This will convert the document to PDF
format and import it into EagleFiler.

e Save files or folders into the To Import folder that’s next to the .eflibrary file in the Finder.
When the library is opened (and, periodically, while it’s open) EagleFiler checks this folder,
imports any files that are in it, and then deletes them.

13



e Choose Import File(s)... from the File menu.
e Choose Import URL(s). .. from the File menu.
e Drag files from one EagleFiler library window to another.

e Select some items or text in another application and choose Import File, Import Text
(Command%), or Import URL from the EagleFiler section of the Services menu (inside
application menu). You may have to log out and log in again after installing EagleFiler in
order for it to appear in the Services menu. You can assign the keyboard shortcuts for the
services in the Keyboard pane in System Preferences or using Service Manager!3 or Service
Scrubber!?.

e Put some text on the clipboard using Edit > Copy and then choose Import Clipboard
from EagleFiler’s Dock menu.

e Run an AppleScript such as:

tell application "EagleFiler"
tell library document 1
import files {POSIX file "/Users/mjt/Desktop/Foo"}
import URLs {"http://www.apple.com", "http://c-command.com"}
end tell
end tell

In all cases, the data is copied into the EagleFiler library (as with iPhoto). EagleFiler automatically
detects duplicate files so that only one copy of each document is stored in the library.

If more than one library is open (and you didn’t drag into a specific browser window), EagleFiler
assumes that you meant to import into the current library (the one with the frontmost window).
If no library is open, EagleFiler will show a dialog asking you to open one; then you can click the
Import button to import the files into that library.

3.3 Don’t Make Changes While Importing

EagleFiler will show a red circle (like a VCR’s Record button) in its Dock icon, while it is importing
files.

It can take a few seconds (or minutes, for large mailboxes) to import a file into EagleFiler. You
should not make any changes to the files being imported during this time. Doing so could cause
EagleFiler to copy the file in an inconsistent state. This also applies to mailboxes. For example,
do not move messages into or out of an Apple Mail mailbox while that mailbox is being imported.

3http://www.blacktree.com/apps/servicemanager/index.html
14http ://www.petermaurer.de/nasi.php?section=servicescrubber

14


http://www.blacktree.com/apps/servicemanager/index.html
http://www.petermaurer.de/nasi.php?section=servicescrubber
http://www.petermaurer.de/nasi.php?section=servicescrubber

3.4 Writing Capture Scripts

You can add support for capturing from additional applications by adding capture scripts to the
folder:

/Users/<username>/Library/Application Support/EagleFiler/Capture Scripts/

A capture script is an AppleScript saved in compiled format. The name of the file is of the form
<bundle identifier>.scpt, e.g. com.apple.Safari.scpt. You can determine an application’s
bundle identifier by finding the CFBundleIdentifier in the Info.plist file inside the application’s
package (which you can open using the Show Package Contents command when Control-clicking
on the application).

The script should have a handler called capture that returns a list of AppleScript records. For
example, the NetNewsWire capture script looks like:

on capture()
tell application "NetNewsWire"
set tabIndex to index of selected tab
if tabIndex is O then
if exists selectedHeadline then
set theURL to URL of selectedHeadline
else
return {{lerror|:"No URL is available to be captured."}}
end if
else
set theURLs to URLs of tabs
set theURL to item (tabIndex + 1) of theURLs
end if
end tell
return {{|url|:theURL}}
end capture

Each record in the list should have a |url| key (for a remote http URL) or a |path| key (for a
full POSIX path). If no items are available for capture, the script can return the empty list, or it
can return a record with a |error| key that provides an application-specific error message.

The capture script for the Finder demonstrates how to capture multiple items at once:

on capture()
tell application "Finder"
set theSelection to selection as list
set theResult to {}

15



repeat with theFile in theSelection
set theFile to theFile as alias
copy {lpathl|:POSIX path of theFile} to end of theResult
end repeat
return theResult
end tell
end capture

If the script creates a temporary file for the capture, it can include a |deleteWhenDone| key with
value true so that EagleFiler will delete the temporary file after it has finished importing the file.

Additionally, the |tags| key (which maps to a list of strings) and the |note| key (which maps to
a string) may be used to specify tag names and note text.

4 Browser Windows

Each browser window contains a source list, a records list, a record viewer, and a toolbar. Drag
the split bars to resize the different portions of the window. Double-click a split bar to collapse it
entirely. Hold down the Option key while dragging a split bar to grow or shrink the window as you
drag.

You can use the Tab key to move between the different panes using the keyboard. When editing
in the record viewer, you may need to type Control-Tab rather than Tab (which will insert a tab
character into the document).

4.1 Source List

Drag files here to import them. You can drop onto a folder or tag source to import files directly
into that folder or to import them and assign that tag. You can use Exposé mid-drag to bring a
window to the front and reveal the source that you want to drop onto.
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The top-level sources are:

Library

All the records in the library, organized the same way as the library’s Files folder in the
Finder. Each file is stored in exactly one folder in the library, and you can drag and drop to
re-arrange files and folders.

Recently Added
The last 25 records (excluding folders) that were added to the library.
Recently Modified

The last 25 records (excluding folders) that were modified within EagleFiler or using another
application.

Tags

Tag sources behave like playlists in iTunes or albums in iPhoto. Select a tag source to view
all the records with that tag. You can drag records onto a tag source to assign that tag to
them. Each record may appear in any number of tag sources. Deleting a record from a tag
source unassigns that tag; the record remains in the library.

Unfiled

Files that are at the top level of the library, e.g. ones that are not in a named folder.
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Trash

The records that have been deleted from the library, but which are still available until you
empty the trash. This corresponds to the library’s Trash folder in the Finder.

You can select more than one source at a time to view all their contents at once. You can type the
first few letters of a source’s name to select it. Press Return to open the selected source in a new
window, or Enter to edit its name.

4.2 Records List

The records list shows the contents of the selected source(s). If a folder or tag is the selected source,
you can drag files into the records list to import them with that folder or tag.
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The columns are:

Tags
The abbreviations for the assigned tags.

Count

The number of pages in a PDF, messages in a mailbox, or attachments in a message.

Icon

An icon that shows the record’s type.

Title

The subject of a message or title of a document.

From

The sender of a message or author of a document.
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The recipient of a message or document.

Date Modified

The date the record’s contents (or its title, filename, or from) was modified.

Date Added

The date the record was added to the library.
Size

The amount of disk space used by the record.
File

The name of the file containing the record.
Kind

The type of the record.

Label
The Finder label of the record’s file.

Container

The name of the folder or mailbox that the record is inside.

You can type the first few letters of a record’s title to select it. Click the 57 to choose which columns
are visible. Double-clicking a record in the list (or pressing Return) is equivalent to choosing Open
in External Viewer. Option-double-clicking is equivalent to choosing Open Source URL. Press
Enter to rename the selected file or Option-Enter to change its title.

4.3 Record Viewer

The record viewer shows the contents of the selected record. Text, RTF, and RTFD records can be
edited directly in the viewer. There is also a bar at the bottom of the viewer for editing the tags
of the current item.
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4.4 Searching

The search box lets you filter the records of the selected sources to display only those records that
match the search criteria.
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Seven different locations may be searched:

Anywhere

Searches the contents of the records, as well as the Title, From, To, Cc, attachment names,
and notes. This is an indexed word search that uses the following syntax:

n

Opening and closing delimiter for phrase-based searching. Phrase-based searches find
records that contain all of the words near each other, but not necessarily in the order
specified.

G)

Opening and closing delimiters for logical grouping.
!, NOT

Boolean NOT.
&, AND

Boolean AND. The <space> character also represents a Boolean AND.
Boolean inclusive OR.

Wildcard for prefix or suffix. Ignored in phrase-based searches. To search for a partial
word, use two *’s, e.g. *ant* will find ant, repellant, anthem, and words with ant
in the middle. If Match Partial Words is checked, EagleFiler will find partial word
matches without your having to type the wildcards each time.
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Filename

This is an exact search of the filenames as displayed in the records list.

From

This is an exact search that examines both the names and addresses.
Tags

This is an exact search for the tag names that you enter.
To/Cc

This is an exact search that examines both the names and addresses.

Title

This is an exact search for record titles and message subjects.

Notes

This is an indexed word search (as with Anywhere) of the notes of the displayed records.

You can restrict a search to records with certain tags by adding tag:<tagname> at the beginning
of the query. The search will then match only the records with all of those tags. For example,
searching for tag:apple steve means to search for steve and show only the records with the
apple tag. Searching for tag:mac tag:ipod halo !bungie means to find all the records that
include the word halo, do not include the word bungie, and have both the mac and ipod tags.

5 Menus

5.1 The EagleFiler Menu
5.1.1 About EagleFiler

The About EagleFiler window shows the credits, as well as download and support information.

You can always download the latest version of EagleFiler from the EagleFiler Web site!®.
Questions about EagleFiler may be sent to eaglefiler@c-command.com!®. I'm always looking to
improve EagleFiler, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of EagleFiler, you can use the Software Update
feature or subscribe to the EagleFiler News mailing list'”. The traffic on this list is very low, only
one message per new version of EagleFiler.

Yhttp://c-command.com/eaglefiler/
Bpailto: eaglefiler@c-command.com
"http://c-command.com/eaglefiler/support
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The EagleFiler RSS feed'® contains update notices and other EagleFiler news.

The EagleFiler forum! is the place to talk with other EagleFiler users, share tips and tricks, and
ask questions.

5.1.2 Software Update

Click the Check Now button, and EagleFiler will tell you whether a newer version is available for
download. By default, EagleFiler will automatically check for new versions each time it is launched
and once per day. You can disable this feature by unchecking the checkbox.

If a new version is available, EagleFiler will tell you what’s new in that version. Click Download
to have EagleFiler download the .dmg file for the new version to your Internet downloads folder.
Click Download & Install to have it download the .dmg and then update the installed EagleFiler
application to the new version.

To check for a new version, EagleFiler contacts a Web server at dreamhost.com. EagleFiler trans-
mits the following information to the server: the name of the product (EagleFiler) and its version,
the version of Mac OS X, whether EagleFiler is registered, and the name of the current language.
This information is used to guide future development. No personal information is transmitted.

5.1.3 Purchase

This window lets you buy EagleFiler. If you’ve already purchased EagleFiler but it’s running in
demo mode, you can you enter your name and serial number to personalize your copy of EagleFiler
and remove the demo limitations.

EagleFiler has a free trial period that lasts for 30 days or 7 launches, whichever is longer. To use
EagleFiler beyond the demo period, you must purchase it. This entitles you to free updates and
support.

To purchase, choose Purchase. .. from the EagleFiler menu. You can use the Purchase button
to enter the online store.

Soon after paying, you’ll receive an e-mail with your serial number. Enter the name and serial
number from the e-mail into the Purchase window and click Personalize. If you need to re-
install EagleFiler, you can simply re-enter your name and serial number and click Personalize;
there’s no need to purchase again.

If you purchased EagleFiler but cannot find your serial number, click the Lost Your Serial
Number? button. This will open a form where you can enter your e-mail address and look up

¥http://c-command.com/blog/category/eaglefiler/feed
¥http://c-command. com/forums/forundisplay . php?f=7
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your order information.

A license for EagleFiler is good for one person or one computer. You can install it on one Mac,
and everyone sharing that Mac can use it (on that Mac). Alternatively, you can install it on your
desktop Mac and your laptop; you can then use it on either machine, provided that no one is using
it on the other machine.

5.2 The File Menu
5.2.1 New Library...

Creates a new library. Each library is a folder containing a Files folder, a Notes folder, a To Import
folder, and a .eflibrary file. Double-click the .eflibrary file to open the library in EagleFiler.
You can move the library folder around in the Finder (when it isn’t open in EagleFiler), but do
not modify its contents.

8086 | Sample Library =
10 items, 40,61 GE available
N & Kind =
v |8 Files Folder
¥ ¥ Mews Fodder
# Daring Fireball= ... Keys?.webarchive Wik archive
# Return to moon ...d.com.webarchive Wik archive
B [ Products Folder
= K0 Programming Faider
B |4 Publications Folder
= | Trash Folder
B |0 Notes Folder
& Sample Library eflibrary EagleFiler Library

The Encrypt library using passphrase option lets you store the library on an encrypted disk
image. The entire library (including all the files, notes, and indexes) will be stored in a single
.sparseimage file that is encrypted using AES-128%0. To access the library, double-click the
.sparseimage file and enter the library’s passphrase. The library will appear as a white icon on
your desktop, and you can double-click the .eflibrary file to open it in EagleFiler. (You can also
access all the files in the library directly from the Finder.) When you’re done with the library,
close it in EagleFiler and eject the library from your desktop to lock it again. Now it can only be
accessed by people who know the passphrase.

2Ohttp ://en.wikipedia.org/wiki/Advanced Encryption_Standard

24


http://en.wikipedia.org/wiki/Advanced_Encryption_Standard

You can quickly access an encrypted library by creating an alias of its .eflibrary file. When
you double-click the alias, the Finder will ask for the passphrase and then open the library with
EagleFiler.

An encrypted library will only consume the amount of disk space needed to hold its files, indexes,
and temporary files. However, you must set a maximum library size that controls how large the
library can grow. The larger the maximum size, the more overhead there is for encryption. For
example, a library with a 1 GB maximum size will have about 26 MB of overhead, while a library
with 500 GB maximum size will have about 111 MB of overhead.

5.2.2 New Folder. ..

Creates a new folder in the source list of the current library. You can set a custom icon for the
folder by selecting it in the Finder, choosing File > Get Info, clicking on the icon, and pasting
your own image.

5.2.3 New Rich Text File

Creates a new RTFD file inside the selected source. If the File column is visible, EagleFiler brings
it into edit mode so that you can set the name of the newly created file. Otherwise, EagleFiler
opens a sheet that lets you enter the title and contents for the new file. You can press Enter to
dismiss the sheet and use Control-Tab to jump back and forth between the text fields.

5.2.4 New Browser Window

Creates an additional browser window for viewing the contents of the current library.

5.2.5 New Tag

Creates a new tag and selects it in the source list. If records are selected, they are assigned the
new tag.

5.2.6 Open Library...

Opens a .eflibrary file, letting you view the library in EagleFiler.

When you open a library, EagleFiler will automatically verify that all of the files are present, backup
the metadata, and copy the tags to the Spotlight comments (if you've selected that option). To
skip these operations, hold down the Shift key when opening the library.
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If you hold down the Command and Option keys when opening a library, EagleFiler will show
the Rebuild Indexes dialog. Rebuilding increases the speed of Anywhere and Notes searches,
compacts the index, and repairs any damage to it. For example, you might want to rebuild the
indexes if you've deleted a lot of files from the library, or if an Anywhere or Notes search is not
finding a record that you think should be in the index.

When rebuilding an index you can choose whether EagleFiler should index words or phrases. In-
dexing for word searches is much faster, but searching for multiple words will find all the documents
that contain those words anywhere in the document. Indexing for phrase searches lets you search
for a group of words that appear near each other in a document, however indexing will take longer
and the index files will be several times as large.

5.2.7 Import URL(s)...

Opens a sheet for importing one or more URLSs into the current library as Web archives. The text
box will be pre-filled with the contents of the clipboard.

5.2.8 Import File(s)...

Opens a sheet that lets you choose one or more files or folders to be imported into the current
library.

5.2.9 Export...

Opens a sheet that lets you choose a folder to which the selected records will be exported. Individual
selected e-mail messages will be exported as .emlx files that can be opened by Apple Mail.

Please note that, because the library is open, it is not necessary to export files in order to open
them with other applications. You could instead use the Reveal In Finder command to access the
actual files that reside in EagleFiler’s library. The Export... command is intended for when you
want to make copies of the selected files or when the selected records are scattered throughout the
library so that they would not be easy to access from the Finder.

5.2.10 Backup Metadata

Metadata is EagleFiler-specific information such a record’s title, from name, checksum, source URL,
tags, and notes. It is stored inside the .eflibrary file.

EagleFiler will automatically backup a libary’s metadata when it’s opened and also periodically
thereafter. You can manually backup the metadata by holding down the Option key and choosing
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Backup Metadata from the File menu.

Metadata is backed up to EagleFiler Metadata.plist files inside the library folder. These are
standard Mac OS X property lists that can be viewed in TextEdit and processed by many other
programs.

Normally when you import a file it will have no metadata except that which can be extracted from
the file itself, e.g. the title and author of a PDF or the source URL of a Web archive. If you import
a file that has backed-up medatadata, EagleFiler will restore all of the metadata from the backup.

5.2.11 Empty Trash...

Empties the trash of the current library.

5.3 The Edit Menu

5.3.1 Undo/Redo

Most actions in EagleFiler can be undone and redone, and EagleFiler supports multiple levels of
undo. When you close a library or empty the trash, EagleFiler clears the list of undoable actions
for that library.

5.3.2 Copy

Copies the selected text, the titles of the selected records or sources, or the names of the selected
tags.

5.3.3 Copy Record Link

Copies a x-eaglefiler URL to the clipboard for each selected record. Opening the URL will
launch EagleFiler, open the library, and select the record so that its contents are shown in the
viewer.

Instead of copying and pasting, you can also drag a record into a text view to create a link to it.

Links will continue to work as you re-arrange the files within the library. However, if you move
the library folder or rename the .eflibrary file in the Finder, previously copied x-eaglefiler
URLs for that library will break. Links to individual e-mail messages will break if you merge the
message’s mailbox with another mailbox, as that will delete the original mailbox.
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5.3.4 Copy Source URL

Copies the original http URLs for the selected Web Archive records. For other kinds of records,
copies file URLs for the files in the library.

5.4 The View Menu
5.4.1 Message > Raw Source

If this is checked, the viewer will show the raw RFC-8222! source for e-mail messages. If it’s
unchecked, the viewer will instead show the Subject, From, Date, To, and body of the message.

5.4.2 Message > Plain Text

If this is checked, EagleFiler will show all e-mail messages in plain text format. For HTML-only
messages, a plain text representation will be created. If this is unchecked, HTML messages will be
shown using rich text and plain text messages will be shown in plain text.

5.4.3 PDF > Next/Previous Page

These commands let you control which page of a PDF is displayed in the record viewer. There are
several ways to change the page without using the menu bar:

e (lick on the PDF page, so that it gets keyboard focus, and then press the Down or Up arrow
key.

e Control-click on the PDF page and use the commands in the contextual menu.

e Use the View > Customize Toolbar command to add toolbar buttons for changing the
page.

e Use the Keyboard pane of System Preferences to add keyboard shortcuts for Next Page
and Previous Page.

5.4.4 Show > Source List

Hides or shows the source list. As a shortcut, you can double-click on the divider.

2nttp://www.ietf.org/rfc/rfc0822.txt
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5.4.5 Show > Record Viewer

Hides or shows the record viewer. As a shortcut, you can double-click on the divider.

5.4.6 Show > Deleted Messages

E-mail messages that you’ve deleted are still stored in their mailbox files, but they are hidden from
view. This option lets you see all of the messages, even the deleted ones. To undelete a message,
select it and press Delete.

5.4.7 Show > Messages in Library Source

If this is checked, EagleFiler will show e-mail messages (from all your mailboxes) as well as files in
the library source. Uncheck it if you want to avoid the clutter of seeing all the e-mail messages, or
if viewing the library is slow because you have lots of messages. This setting is saved per-library.

5.4.8 Show > Messages in Tag Sources

If this is checked, EagleFiler will show e-mail messages (from all your mailboxes) as well as files
in tag sources. Uncheck it if you want to avoid the clutter of seeing all the e-mail messages, or if
viewing tag sources is slow because you have lots of messages. This setting is saved per-library.

5.4.9 Allow Editing in Record Viewer

This controls whether Text, RTF, and RTFD records can be edited directly in the record viewer,
without opening the file in another application. You might uncheck this if you want to avoid making
accidental changes while viewing a record.

5.4.10 Previous/Next Record

These commands select the previous or next record in the record list. This lets you change which
record is being viewed while the viewer pane has keyboard focus.

When the records list or the record viewer has keyboard focus, you can type Spacebar or Shift-
Spacebar to select the next or previous record.
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5.4.11 Select Source

If you have a folder or mailbox selected in the record list, this command reveals and selects it in
the source list. Otherwise, the container of the selected record is selected in the source list.

For example, if the Library source is selected, you can use the search box to enter the name of
the folder that you want to view, select it in the record list, and then choose Select Source. This
is often quicker than expanding the various folders inside the Library source to find the one you
want.

5.4.12 Open in New Window

This opens a new browser window in EagleFiler to view the selected records.

5.5 The Format Menu

This menu contains commands for use when editing a rich text file in FagleFiler’s viewer or when
editing a note. You can change the font and style and add clickable links, lists, and tables. In
addition to the standard Mac OS X formatting commands, EagleFiler provides a command called
Highlight, which makes the background of the selected text yellow, as if it had been drawn over
with a highlighter.

5.6 The Record Menu
5.6.1 Mark Unread/Read

Add (or remove) the “unread” tag to the selected records.

5.6.2 Flag/Unflag

Add (or remove) the “flagged” tag to the selected records.

5.6.3 Tag

Gives keyboard focus to the tags text field at the bottom of the browser window, which lets you
edit the tags of the selected record.
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5.6.4 Show Inspector

This window lets you view and edit the properties of the selected records. You can type Tab to
move between to text fields, or Control-Tab to move out of the notes text view.
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B8.68.6 Apple - iMac Info

LgJ Apple - iMac.webarchive
Web Archive (420 KB)

Title: Apple - iMac

From: apple.com

Modified: October 12, 2006 4:15:30 PM EDT
Added: October 12, 2006 4:15:30 PM EDT

Label: | () None I-H
Tags: buy note
-
Motes:

Graphics and Video

. 17-inch model with 1.83CHz processor
. Intel GMA 950 graphics processor with 64MEB of DDR2
SDRAM shared with main memaory
. 17-inch model with 2.0CGHz processor and 20-inch model
«  ATI Radeon X1600 graphics processor using PCI
Express
. 12BME of CDDR3 SDRAM
. Optional 256MB of GDDR3 SDRAM on 20-inch model
* 24-inch model
. MNVIDIA GeForce ¥300 GT graphlcs processor with
126ME of GDDR3 SDRAM using PCI Express
. Optional NVIDIA GeForce 7000 GT graphics processor
with 256MB of GDDR3 SDRAM using PCI Express

File Properties

This shows the file’s name, kind, size, and dates, as well as EagleFiler metadata such as the
title, from, and to.

If a record doesn’t have a title and you haven’t set one manually, EagleFiler will use the
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filename (without the extension) as the title, and the title will stay in sync with the filename
if you rename it.

Label
This is the Finder label of the file. In EagleFiler, the label is shown as the background color
in the records list and also in the Label column. E-mail messages are stored as mailboxes,
not as individual files, so all the messages in the mailbox share the mailbox file’s label. You
can edit the label names from the Finder’s Preferences window.

Tags
This shows the tags assigned to the record. You may find it more convenient to create and
assign tags by typing them in the text field than by using the Show Tags command.

Notes

Notes support rich text, clickable links, embedded graphics, tables, etc. Most of the commands
for editing notes are in the Format menu. As a shortcut, you can type Option-Tab to start
a bulleted list or Option-Shift-Tab to dedent the current list item.

5.6.5 Show Tags

This window shows a list of tags for the current library.
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The columns are:

vV

The box is checked if all of the selected records in the browser window have this tag. It shows
a - sign if some (but not all) of the selected records have the tag. It is disabled if no records
are selected.

The abbreviation (if any) for the tag. Abbreviations are shown in the Tags column of
the records list; for example, the “unread” tag is shown as a blue e. Double-click on an
abbreviation to edit it. The abbreviation can be composed of ordinary letters, or of special
symbols that you access using the Characters button in the toolbar.

Name

The name of the tag. Double-click on a name to edit it. (The names of built-in tags such as
“unread” cannot be edited.) Each tag must have a unique name.

You can give the tags palette keyboard focus by:
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Clicking in its title bar.

Choosing Show Tags from the Record menu.

Clicking the Tags button in the toolbar of a browser window.

Editing an abbreviation or name.

Once the tags palette has keyboard focus, you can:

e Type the first few letters of a tag’s name to select it in the list.

e Press the spacebar to toggle whether the selected records in the browser window have the
selected tags. This is like checking or unchecking the boxes of all the selected tags at once.

e Click the Colors button in the toolbar. Then choose a new color for the selected tag(s) and
abbreviation(s).

5.6.6 Convert For Editing

Converts the selected Web archives to (editable) rich text files, preserving the tags, notes, source
URL, and other metadata.

5.6.7 Merge Mailboxes

Merges the selected mailboxes into a single mailbox file with the name and location of the oldest
mailbox in the selection. The tags and notes of the messages are preserved. The original mailboxes
are then moved to the trash.

Merging mailboxes can reduce clutter in the source list and speed up EagleFiler.

5.6.8 Reply to Message

Lets you reply to a message in your default e-mail program.

5.6.9 Verify

Checks the selected records and their notes to make sure that the files are not damaged. If EagleFiler
finds that a file has changed then either the file is damaged or you edited it without EagleFiler’s
knowledge. If the file is damaged you can replace it with a backup. If you modified the file, you
can use the Update Checksum command to tell EagleFiler that it is not damaged.

35



5.6.10 Update Checksum

Tells EagleFiler that the selected records are not damaged. EagleFiler will calculate and store the
checksums of the files so that when you later use the Verify command it can see whether the files
are different from the way they are now.

EagleFiler will automatically update the checksums of files that you edit from within EagleFiler.
Use the Update Checksum command if you have edited a file using another program; this tells
EagleFiler that the file has changed because you modified it, not because it became damaged.

5.6.11 Open in External Viewer

Opens the selected records in a specialized viewer application such as Preview, Safari, or Mail.
Folders and mailboxes will open in a new window in EagleFiler.

If a search is in effect, EagleFiler passes the search string to the external viewer so that it can show
you the matches in the document.

Double-clicking a record and pressing Return are shortcuts for choosing this command from the
menu. Hold down the Option key to open the source URL instead of the stored file.

To change which application will open a document, use the Reveal in Finder command, then choose
Get Info from the Finder’s File menu and look in the Open with section of the info window.

5.6.12 Open Source URL

With a Web archive record (or an RTFD file converted from a Web archive) selected, this opens
the (live, not archived) Web page in your Web browser.

You can also Option-double-click on a record to open its source URL.
5.6.13 Open in del.icio.us

This opens a Web archive’s URL in the del.icio.us?? social bookmarking site to help you find related
pages.

2Znttp://del.icio.us
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5.6.14 Reveal in Finder

This shows the selected records in the Finder. If you have Path Finder?? running, the files will be
revealed in it instead.

5.7 The Window Menu

5.7.1 Activity Viewer

EagleFiler can do many operations—such as adding files and URLs to the library, indexing,
verifying—in the background. This window shows a list of the tasks that EagleFiler is currently

working on for each library.

e0e Activity Viewer

Sample Library: Indexing records |

b I e e
. L0 "

Sample Library: Indexing messages in "TIdBITS"

-
- ':
12 of 103 — About 35 seconds

Sample Library: Rebuilding mailboxes
u L A A LA LR LR LR LR R LR R R R

Wi

PR

‘Waiting for other operations

|

5.7.2 Drop Pad

You can drag files onto the Drop Pad to import them into the current library. The current library
is the library whose browser window is in the front. You can use the pop-up menu on the Drop Pad
to change the current library (without introducing window clutter). The Drop Pad also provides
information about whether EagleFiler can capture from the current application.

2nttp://www.cocoatech. com
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AAD Drop Pad

Drag and drop here to add to the library.

Library: | Sample Library ke

5.7.3 Errors

This window shows a list of errors that have occurred since you launched EagleFiler.

5.8 The Help Menu

This menu provides access to the full EagleFiler documentation (in Apple Help or PDF format) as
well as a link to the technical support Web site.

5.9 The Dock Menu

The Capture From <Application> command is equivalent to pressing the capture key. The
Import Clipboard command will import any text on the clipboard as a new rich text file. The
Open Recent commands let you access EagleFiler libraries that might not currently be open.
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6 Preferences

e 0 Preferences
Capture key: F1 Set...
Sources font: Lucida Grande 11 Select...

W Use small source icons

Lists font: Lucida Grande 11 Select...
Rich text font: Helvetica 12 Select...

Plain text font: Motaco 9 Select...

Search highlight color:

: Quoted Text Colors

e 480

Level 1 Lewvel 2 Lewvel 3 Level 4 Lewvel §

W Remember open libraries between launches
™ Copy tags to Spotlight comments

6.1 Capture Key

You can always import into EagleFiler using Import URL(s). .., Import File(s). . ., or drag and drop.
However, if you are already viewing the information that you want import in another application,
it’s much easier to just press the capture key. When you press the capture key (F1 by default—
notebook users may also need to hold the fn key), EagleFiler automatically determines what you're
currently viewing and imports it into the current library. EagleFiler will play a camera sound to
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let you know that the capture has started. When it’s finished, if you have Growl?*

see a notification bubble.

installed, you’ll

EagleFiler can capture from these applications:

BBEdit
Captures the file of the first document of the front window.

Camino

Captures the URL of the current tab.

Cocoalicious

Captures the URLs of the selected posts, preserving the tags and the description and extended
description.

DEVONagent
Captures the URL of the front browser window.

DEVONthink Pro

Captures the selected items, preserving the comments.

Endo

Captures the selected news items as Web archives, preserving their tags and importing the
excerpts as notes.

Finder

Captures the selected files in the front window.

Firefox

Captures the URL of the current tab.

Flock
Captures the URL of the current tab.
iCab
Captures the URL of the front window.
Journler
Captures the selected documents, preserving their tags.
Mail

Captures the selected mailboxes or messages in the front viewer window. Tags, projects, and
annotations from MailTags?® are preserved.

2nttp://growl.info
nttp://www.indev.ca/MailTags.html
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Mailsmith

Captures the selected mailboxes. You may find it helpful to use Email Archiver?® to separate
messages by age before importing them into EagleFiler.

Microsoft Word
Captures the file of the front window.

Netflix Freak
Captures the URLSs of the selected movies.

NetNewsWire (but not NetNewsWire Lite)

Captures the URL of the current tab, or the URL of the selected headline (if no tab is
selected).

Nisus Writer Express

Captures the file of the front window.

OmniWeb
Captures the URL of the current tab.

Path Finder

Captures the selected files in the front window.

PDFView
Captures the file of the front window.

Safari

Captures the URL of the current tab. Some Web pages (e.g. some sites that require logging
in) cannot be captured by loading the URL shown in Safari’s location bar. You can import
such pages into EagleFiler by using Safari’s File > Save As... command to save the page as
a Web archive (perhaps into the To Import folder of an EagleFiler library), or by choosing
File > Print and then selecting Save PDF to EagleFiler from the PDF button menu.

Skim
Captures the file of the front window.

SubEthaEdit
Captures the file of the front window.

TextEdit
Captures the file of the front window.

Text Wrangler
Captures the file of the first document of the front window.

2nttp://www.garrison.com.au/freeware/emailarchiver.html
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Vienna

Captures the URL of the last selected post.

WebnoteHappy
Captures the selected URLs as Web archives, preserving the tags and notes.
Yojimbo

Captures the selected items, preserving the tags and comments.

If you’d rather import just the selected text instead of the entire Web page or document, you can
use EagleFiler’'s Import Text service (Command%) instead of the capture key.

In some cases, EagleFiler captures the information directly from the application’s internal storage.
Thus, you should not modify it while the capture is in progress. For example, do not check for new
mail or move messages between mailboxes while capturing from Mail. If you are capturing from
the Finder or Path Finder, do not modify the files during the capture.

EagleFiler must be running in order for the capture key to work. Thus, you may wish to add
EagleFiler to your Login Items in the Accounts pane of System Preferences. You can easily do
this by clicking on the EagleFiler icon in the Dock and choosing Open at Login.

6.2 Fonts

Sources

Used in the source list in browser windows.

Lists

Used in the records list in browser windows and in the list of tags in the tags inspector.

Rich text

Used for e-mail header information, HTML messages, and as the default font for notes.

Plain text

Used for plain text e-mail messages.

The fonts for Web archives are mostly controlled by the Web archives themselves. The default font
families and sizes can be controlled using Safari’s preferences.

6.3 Search highlight color

This is the color that EagleFiler uses to emphasize the search terms in the items list and record
viewer.
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6.4 Quoted Text Colors

EagleFiler colors plain text e-mail messages according to the number of quote characters at the
start of each line. The pop-down menu lets you choose a preset coloring scheme.

6.5 Remember open libraries between launches

If this is checked, EagleFiler will remember which libraries were open when you quit it, and it will
re-open them the next time EagleFiler is launched.

In addition, you can put aliases to your favorite libraries in the folder:
/Users/<username>/Library/Application Support/EagleFiler/Startup Items

so that EagleFiler will always open them at launch. You can hold down the Shift key at launch to
prevent it from re-opening the libraries or opening the startup items.

6.6 Copy Tags to Spotlight Comments

If this is checked, EagleFiler will set the Spotlight comments for each file to the names of the tags
that it’s been assigned. This enables you to search for a file using Spotlight by typing tag names
as part of the query. Any existing comments will be lost.

6.7 Esoteric Preferences

You can set esoteric EagleFiler preferences by clicking the links on this page. Unlike with regular
preferences, you must generally quit and re-launch EagleFiler in order for an esoteric preference to
take effect.

AllowDuplicateFiles

Normally EagleFiler will prevent you from importing a file that’s identical to one that’s
already in the library. You can allow duplicate files in the library or forbid them.

HighlightSearchMatches

Normally EagleFiler will highlight in the record viewer the words that match your search
query. Disabling this feature will provide a speed increase.

MarkNewRecordsAsUnread

Normally EagleFiler will mark newly imported records as unread, but you can also tell it to
leave them untagged.
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7 Frequently Asked Questions

7.1 Why doesn’t my serial number work?

You need to enter the serial number name and serial number exactly as they appear on your order
confirmation e-mail. If you no longer have this e-mail, you can look up the name and number.
Launch EagleFiler and choose Purchase from the EagleFiler menu. Then click the Lost Your
Serial Number? button.

7.2 How can I speed up EagleFiler?

Getting a faster Mac, a faster hard disk, or more RAM would of course make everything faster,
but there are also some less expensive ways to speed up EagleFiler:

1. EagleFiler is designed to perform best when it is kept running, with a library open. It
will be faster to leave it running (perhaps hidden) in the background than to open and
close it each time you add a file to the library. Additionally, leaving EagleFiler running
will allow you to use its capture key.

2. If you just want to add a file to a library, without waiting to open the library or
EagleFiler, you can save the file in the library’s To Import folder so that it will be
imported the next time EagleFiler opens that library.

3. EagleFiler is designed to support multi-gigabyte libraries with many thousands of files.
However, as with all software, viewing a library (or folder) with fewer files in it will
generally be faster than viewing one with many. (The sizes of the files don’t have much
effect on EagleFiler’s performance.) EagleFiler lets you create multiple libraries, so one
way to increase performance is to use several smaller libraries instead of one huge one.
This can also provide an additional level of organization.

4. Fewer large mailboxes are faster than many small ones. You can combine multiple
mailboxes using the Merge Mailboxes command.

5. Emptying EagleFiler’s trash will reduce the number of records in the library, and thus
speed it up.

6. Importing files is faster when nothing is selected in the source list and the Activity
Viewer window is closed.

7. In order to enable quick searching, EagleFiler maintains indexes of all the files and
e-mail messages in a library. By default, EagleFiler indexes for phrase searches. This
allows the most flexible searching, but indexing can take a lot of time and disk space.
If you don’t need to do phrase searches, you can rebuild the indexes for word searching.
This will reduce the size of the indexes and speed up indexing going forward.
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8. Viewing search results in large documents will be faster if you turn off search match
highlighting.

9. When EagleFiler opens a library, it checks to make sure all of the files are present, backs
up the metadata, and copies the tags to the Spotlight comments. You can hold down
the Shift key when opening the library to skip these steps, or click the x buttons in the
Activity Viewer to cancel them.

7.3 How can I move messages between mailboxes?

In order to improve performance and make more efficient use of disk space, EagleFiler stores e-mail
messages in mailbox files (using the standard “mbox” format), and it does not allow them to be
moved from one mailbox to another. Thus, it is best to organize messages into the mailboxes
that you want (and to delete messages that you don’t want to save) before importing them into
EagleFiler. Nevertheless, several organization options are available once your messages are in an
EagleFiler library:

e You can merge multiple mailboxes into one. For example, if each month you import mailbox
A into EagleFiler, you’ll end up with lots of A mailboxes in the library, each containing one
month’s worth of messages. By merging all of the A mailboxes into one, you can reduce
visual clutter and make EagleFiler run more efficiently.

e You can organize messages (from different mailboxes) into tag sources. As with playlists in
iTunes, each message can be in more than one tag source at a time.

e The easiest way to avoid storing duplicate messages is to delete messages in your mail program
after you’ve imported them into EagleFiler. You can also delete individual messages from an
EagleFiler mailbox, although this will not save disk space; it will only hide the messages from
veiw.

8 Legal Stuff

Distribution

Please distribute the unmodified EagleFiler-1.2.dmg file on the Web, LANSs, compilation CD-
ROMs, etc. You may not charge for it (beyond a reasonable cost for media) or distribute the
contents of the disk image file in isolation. You may not distribute your serial number.

Limited Warranty
The software is provided “as is,” without warranty of any kind, express or implied, including but not

limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
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whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

License

A license for EagleFiler is good for one person or one computer. You may install it on one Mac,
and everyone sharing that Mac may use it (on that Mac). Alternatively, you may install it and
use it on multiple Macs (e.g. your desktop Mac and your laptop); then you (and no one else) may
use it on any of those Macs. For multiple users on multiple Macs, you should purchase multiple
licenses.

Copyright and Trademarks

EagleFiler and this manual are copyright © 2002-2007 by C-Command Software?”. All rights
reserved.

EagleFiler is a trademark of C-Command Software. Mac is a registered trademark of Apple Com-
puter. All other products mentioned are trademarks of their respective owners.

Components
The following open-source components are used in EagleFiler:

Regular expression support is provided by the PCRE?® library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

Thanks to Allan Odgaard for some code snippets that are used in the Software Update installer.
1ibffi2?: Copyright © 1996-2003 Red Hat, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, in-
cluding without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EX-
PRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MER-
CHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL CYGNUS SOLUTIONS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,

2

"mailto :mjt@c-command.com
2®nttp: //www.pcre.org
nttp://sourceware.org/libffi/
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ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

PyObjC3Y - Copyright 2002, 2003 - Bill Bumgarner, Ronald Oussoren, Steve Majewski, Lele Gaifax,
et.al.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, in-
cluding without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
S0, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EX-
PRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MER-
CHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Python3!:

1. This LICENSE AGREEMENT is between the Python Software Foundation (“PSF”),
and the Individual or Organization (“Licensee”) accessing and otherwise using this
software (“Python”) in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants
Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test,
perform and/or display publicly, prepare derivative works, distribute, and otherwise
use Python alone or in any derivative version, provided, however, that PSF’s License
Agreement and PSF’s notice of copyright, i.e., “Copyright (©) 2001, 2002, 2003, 2004,
2005, 2006 Python Software Foundation; All Rights Reserved” are retained in Python
alone or in any derivative version prepared by Licensee.

3. In the event Licensee prepares a derivative work that is based on or incorporates Python
or any part thereof, and wants to make the derivative work available to others as pro-
vided herein, then Licensee hereby agrees to include in any such work a brief summary
of the changes made to Python.

4. PSF is making Python available to Licensee on an “AS IS” basis. PSF MAKES NO
REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY WAY OF

30nttp://pyobjc.sourceforge.net/
3nttp: //www.python.org/
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EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DISCLAIMS ANY
REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON WILL NOT IN-
FRINGE ANY THIRD PARTY RIGHTS.

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON
FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS
AS A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON,
OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY
THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its
terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of agency,
partnership, or joint venture between PSF and Licensee. This License Agreement does
not grant permission to use PSF trademarks or trade name in a trademark sense to
endorse or promote products or services of Licensee, or any third party.

8. By copying, installing or otherwise using Python, Licensee agrees to be bound by the
terms and conditions of this License Agreement.

9 Version History

1.2—May 30, 2007

Made a variety of changes to improve EagleFiler’s speed and responsiveness, especially
for libraries with many files.

You can now copy from one library to another via drag and drop. All of the EagleFiler
metadata will be preserved.

The New Library. .. command now offers the option to create an encryped library.
Highlights search matches in the items list and the record viewer.

Each library now has a To Import folder in the Finder. Any files that you save into this
folder will be imported when you open the library (or within the next minute or two if
the library is already open).

You can now delete (and undelete) individual e-mail messages.

Uses the available Spotlight importers to index the content of many types of files that
EagleFiler doesn’t natively understand.

Added Match Partial Words option to the search pop-up. When this is checked, you
can search for partial words without having to type wildcards (*) in the query.

tag:<tagname> searches now work with Filename, From, To/Cc, and Title searches,
rather than just Anywhere and Notes searches.
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Can now capture from Skim?®? and Journler3? (preserving tags).

When capturing from Cocoalicious®?, EagleFiler now preserves the tags and the descrip-
tion and extended description.

Added Backup Metadata command. EagleFiler will automatically backup a libary’s
metadata when it’s opened (unless you have Shift held down) and also periodically after
it’s been opened. You can manually backup the metadata by holding down the Option
key and choosing Backup Metadata from the File menu. Metadata is backed up to
EagleFiler Metadata.plist files inside the library folder. If you import a file that has
backed-up medatadata, EagleFiler will use the stored metadata to set the title, from
name, checksum, source URL, tags, and notes.

Added Copy Tags to Spotlight Comments preference. When this is enabled, you’ll be
able to find files in your library by searching for their tag name using Spotlight.

If you hold down the Command and Option keys when opening a library, you can access
the new Rebuild Indexes dialog. This lets you optimize or repair EagleFiler’s search
indexes, and you can choose whether it indexes for word searches or phrase searches.
Previous versions of EagleFiler always indexed for phrase searches. Switching to word
indexing will speed up EagleFiler’s indexing and substantially reduce the amount of disk
space that the indexes consume.

Added Update Checksum command, so that it’s easier to tell EagleFiler when you’ve
modified a file using another application.

When importing via AppleScript, you can now specify which folder to import into, e.g.
import files {theFile} container theFolder.

It’s now possible to change filenames via AppleScript.

When using Previous/Next Record with the Info inspector in front or the tags bar
focused, the text field will retain its focus as the selected record changes, making it
possible to quickly edit multiple tags/titles/filenames in sequence.

You can now press Option-Delete when viewing a tag source to move the selected records
to the trash rather than unassigning the tag.

Added Esoteric Preferences.

When exporting messages in .emlx format, now includes the tags and notes.

Now shows a determinant progress bar when importing a folder.

No longer shows a progress window when opening a library.

Improved the display of various kinds of multi-part e-mail messages.

No longer shows the children of smart folders in the source list.

Now shows the pointing hand cursor when you hover over a clickable link in a text view.

From the AppleScript interface, it is now possible to access records by name, subject to
the filename being unique.

Added backup metadata AppleScript command.

32nttp://skim-app.sourceforge.net
33nttp://www. journler.com
3nttp://www.scifihifi.com/cocoalicious/
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You can now change the case of a file’s extension.

Updated to Python 2.5.1.

Worked around OS bug that could cause crash when viewing PDFs.
Fixed bug where the note tag could get out of sync.

Fixed bug where creating a link when editing in a rich text view would sometimes insert
the link after the selected text.

Fixed crash when indexing certain QuickTime files.

Fixed bug calculating checksums of certain document packages.

Fixed memory leak with Activity Viewer window.

Worked around Search Kit bug that could cause a crash when doing a phrase search.

Fixed bug where if you drag-imported multiple folders into a folder, the second and
subsequent folders would be imported at the top level.

Fixed bug capturing from Yojimbo 1.4.2.

Fixed bug where the URL colorer didn’t find certain valid URLs.

Fixed bug where EagleFiler allowed duplicate files to be added to the library.
Fixed threading bugs when importing multiple files at once.

When viewing a Web page, if you click on a link to another part of the same page,
EagleFiler now scrolls the window rather than opening the location in a new window.

Modernized the crash reporter code.

Fixed bug where EagleFiler would sometimes keep files open after a library had been
closed.

Fixed bug where the Info inspector showed “()” for the size of a folder.
Fixed bug in reporting library save errors.

Fixed bug where application-level menu commands could get permanently disabled.

1.1.6—March 5, 2007

Now supports searching by filename.
Can now capture from Flock?>.

The interface is a bit more responsive, due to threading improvements when importing,
indexing, and merging.

No longer hangs when indexing a movie with unresolved file references.
No longer uses any CPU time when idle.
Can now import malformed mbox files generated by MailSteward.

Fixed bug where fields in the inspector could lose their focus when a background oper-
ation completed.

Fixed bug dropping onto an item inside the Trash source.

3nttp://www.flock.com
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Fixed regression displaying contents of multiple folder sources.
Fixed regression where new rich text records weren’t auto-selected.

Improved error handing during menu/toolbar validation.

1.1.5—February 20, 2007

Worked around a Cocoa bug that could cause a crash when closing a window or open/save
panel.

The Date column is now called Date Modified.
Fixed bug where a record’s cached modified date could get stale.

Fixed bug where closing a window or pulling down the File menu could be slow if there
were messages selected.

Fixed regression where the same mailbox could be indexed by duplicate threads.
Fixed bug remembering the open libraries when quitting.

Fixed display of library names containing slashes.

1.1.4—February 16, 2007

Added Show > Messages in Library Source option. This makes it possible to view and
search everything in the library by selecting the Library source. Previously, to search
e-mail messages you had to select one or more mailboxes; you can still do that, if you
want to restrict the search to just those mailboxes.

The Tags inspector now sorts the assigned tags to the top.

Added Bigger/Smaller commands for adjusting the text size for rich text documents and
Web archives.

You can now omit the Shift key when pressing the keyboard shortcut to zoom in, i.e.
Command-= is now equivalent to Command-+.

Improved URL coloring in messages.

Made various performance improvements, particularly to file indexing, display in the
browser window, and emptying the trash.

Now shows custom file icons (rather than a generic text icon) for files such as OmniGraffle
documents that are in XML format but are not strictly text documents.

Added New Folder button to the Export... dialog.
The Import File(s). .. and Export. .. dialogs are now sheets.
Worked around Search Kit bug that caused crashes when doing phrase searches.

Worked around suspected Cocoa bug that could cause a crash if you pressed Cancel
when creating or opening a library.

Worked around Cocoa bug that could cause the source list not to properly scroll to show
a new tag that had been created.

Fixed bug importing MailTags projects.

Fixed bug where the tags field in the Info inspector didn’t wrap when there were a lot
of tags, or update when the record selection changed.
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Fixed bug where insertion point didn’t advance when pressing Space while editing a
tag’s name in the Tags inspector.

Fixed bug accessing tags via AppleScript.

Fixed bug displaying Web archives.

Fixed problem displaying messages in tag sources if an index file had been damaged.
Improved compatibility with pre-release versions of Mac OS X 10.5.

The Software Update auto-updater is now compatible with FileVault.

No longer shows inaccurate size for folders.

Made various improvements to the error reporting and error logging.

1.1.3—January 25, 2007

Can now capture from DEVONagent¢, DEVONthink Pro®” (preserving comments),
Nisus Writer Express®®, and Yojimbo3? (preserving comments and tags).

Added Copy Source URL to the contextual menu.

Better display of e-mail messages with embedded messages (such as digests and bounced
messages).

You can now use just plain Tab instead of Control-Tab to tab out of the viewer pane in
the browser window when the viewer is a read-only text view.

In the records list, you can now type Option-Enter to edit the title of the selected record.

If a message attachment doesn’t have a name, EagleFiler will list the content subtype
next to the paperclip instead of omitting that attachment.

When capturing from Apple Mail with both messages and mailboxes selected, “Mail-
boxes” is now the default choice.

Better error messages when you try to capture a smart mailbox in Apple Mail.

EagleFiler cannot import mailboxes from Apple Mail on Mac OS X 10.3 and earlier.
Rather than importing the mailboxes as folders, it now reports an error.

Can now import more types of text clippings.

Spaces in tag names are now converted to underscores instead of being deleted.
Fixed error when pressing Enter in the records list.

Fixed bug where capturing packages from the Finder didn’t work.

Fixed bug where the scroll position and selection in the notes editor would be messed
up when switching to another application.

Worked around a Web Kit bug that caused it to needlessly fetch archived portions of a
Web page over the network, or not display them at all if you were offline.

Worked around a Web Kit bug when displaying a Web archive created from a local
HTML file.

36http:
37http:
3¥nttp:
39http:

//www.devon-technologies.com/products/devonagent/index.html
//www.devon-technologies.com/products/devonthink/index.html
//www.nisus.com/Express/
//www.barebones.com/products/yojimbo/

52


http://www.devon-technologies.com/products/devonagent/index.html
http://www.devon-technologies.com/products/devonthink/index.html
http://www.nisus.com/Express/
http://www.barebones.com/products/yojimbo/

Fixed bug where Reveal In Library sometimes looked in the wrong library.
Fixed error undoing in the tags fields.
Fixed error using the Highlight command with no selection.

EagleFiler’s helper tools don’t use the URL cache, so now they tell Web Kit not to store
one.

1.1.2—January 9, 2007

Tabbing between the source list, records list, and viewer works much better, as EagleFiler
now overrides the Cocoa keyboard loop.

You can now press Enter in the records list to edit the filename or press Return to open
the selected records.

Can now capture from PDFView?.
AppleScript enhancements:
— Added import text command, which takes a string and creates a new rich text file

in the library.

— You can now access the open browser windows along with their displayed records
and selected records.

— Added note file and trashed properties to library record. Also, various for-
merly read-only library record properties are now writable.

— Added container property to tag.

If you click the + button in the browser window with the Tags folder or a tag selected,
EagleFiler will create a new tag instead of a new folder.

EagleFiler is more responsive when emptying the trash, as the lengthy index updating
now takes place in a background thread. Also, EagleFiler now compacts the search index
when emptying the trash, which should reduce the disk space used and speed up future
searches.

Added a hidden preference to make EagleFiler not check for duplicate files during im-
porting. Click the link to allow duplicate files or to forbid them.

Worked around PDF kit bug that could cause repeated zooming out when viewing a
PDF.

Fixed bug where EagleFiler didn’t recognize document packages when importing a folder
full of files.

Fixed regression where EagleFiler could freeze when clicking an X button in the Activity
Viewer.
If the library changes while you’re in the middle of editing a table cell or text field, Ea-

gleFiler will no longer replace your in-progrss changes with the value from the database,
nor will it mess up the insertion point.

When following an EagleFiler link, if the specified library can’t be found, but one with
the same name is already open, EagleFiler will try to use that library to open the link.

“Onttp://pdfview.sourceforge.net
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Made various changes to improve the responsiveness of the interface.

Faster file deletions, with better threading, should improve the performance of all back-
ground operations that create temporary files.

Fixed crash when logging indexing errors.
Worked around some framework bugs that could cause a variety of different crashes.
The indexer recovers better when a file is unexpectedly deleted.

Worked around Cocoa bug that could cause some tags to be removed if you ended editing
in a tags field by pressing Return when the insertion point wasn’t at the end of the field.

Fixed regression where changes to the tags weren’t saved when closing the Info inspector.

Text filenames are now allowed to have no text before the extension, so you can now
store and rename “dotfiles” in EagleFiler.

It is now possible to edit the extensions of text files.

If you launch EagleFiler by dropping a file onto it, it will now open the default library
before importing the file rather than complaining that no library is open.

Added blank line before the source URL in the records list tooltip.

No longer brings the Errors window to the front (which was undesirable if you were in
the middle of typing something) when an error occurs—instead, it just makes sure the
window is visible.

2

The mailbox importer now handles messages that start with “>From ” instead of a

header.

Better handling of encrypted PDF's.

Better error reporting in Endo capture script.

Better error message when can’t capture from Mail.
Fixed bug logging errors during mailbox rebuild jobs.

Fixed bug where browser windows didn’t remember whether the trash source was ex-
panded between launches.

Fixed bug where Command-Right Arrow and Command-Left Arrow didn’t work in text
views.

Fixed bug where Reveal In Library didn’t work for records that were in the trash.

Simplified the Purchase window.

1.1.1—December 18, 2006

When capturing a selection of files from the Finder, Spotlight comments may now be
imported as tags or notes.

Can now capture from Microsoft Excel.

The keyboard shortcut for Import Text is now Command-% instead of Command-<, as
the latter conflicted with a system-wide shortcut when using certain keyboard layouts.

When creating a rich text record using text dragged from Safari (or, generally, any
WebView), EagleFiler will now set the source URL and add it to the bottom of the text.
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You can now create records by dragging text selections from within EagleFiler to its
source list or records list.

After you choose Convert For Editing, EagleFiler will now select the newly created RTFD
files rather than leaving the original Web archives selected.

When pasting the results of Copy Source URL into a rich text view, the clickable text
is now the URL itself, rather than the title, and no trailing newline is added.

Added source URL to tooltip in records list.
Generates better titles from dragged text.

If you change the PDF view away from Zoom To Fit, it now remembers the current scale
factor.

Improved the speed of the initial index check when opening the library.
Improved parsing of mbox files.
Fixed bug where capturing some URLs didn’t work.

Fixed bug where, when opening a new window to display a record, the record wasn’t
always selected.

Fixed bug where EagleFiler could hang if you tried to edit the title or filename of a
record while it was doing something else.

Fixed regression where importing via drag and drop from another application sometimes
didn’t work.

Fixed bug and reduced RAM usage when importing a large number of files/folders at
once.

Fixed bug where the source list or records list would go into edit mode when you clicked
on it and it didn’t already have focus.

Fixed bug where a PDF or Web archive would needlessly be scrolled to the first page.
Stopping indexing operations by clicking the X button works better now.

Indexing no longer hangs if there’s a problem loading a Web archive or if it’s corrupt.
Worked around OS bug that prevented some Word documents from being indexed.
Fixed bug reporting errors while adding a file to the library.

Better error reporting for damaged Web archive files.

Fixed bug where tag sources showed messages for mailboxes that were in the trash.
Fixed bug where child tags weren’t sorted in the source list.

EagleFiler no longer lets you give a tag an empty name.

Worked around issue when saving libraries on Leopard.

Worked around OS issue that caused EagleFiler to be the default opener for Word files.

Worked around some bugs in libraries that EagleFiler uses, which caused errors when
importing text via drag and drop.

Better error reporting when can’t write a temporary file or save the library.

The contextual menu now says Delete instead of Move To Trash, since deleting from a
tag source doesn’t move to the trash.
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1.1—December 6, 2006

Importing

EagleFiler will now let you import any kind of document. If it doesn’t know how
to display the document, it will simply show the file’s icon, which you can click to
open it in another application.

When importing via drag and drop, you can now drop onto folders or tags in the
source list or into the records list in order to put the imported records into that
folder or assign them that tag.

Now recognizes many more kinds of text files and text clippings.

Can now import individual messages from Entourage via drag and drop.

Added Command-< keyboard shortcut for the Import Text service.

You can now import by control-clicking on a file in the Finder and choosing Open
With > EagleFiler.

Added Import Clipboard command to the Dock menu.

It is now possible to specify tag names and note text when importing via AppleScript.

Capture

Can now capture IMAP mailboxes and individual selected messages from Apple
Mail.

Can now capture from Endo*!, Firefox*?, and WebnoteHappy*3.

If you press the capture key when there is no library open or while in an unsupported
application, EagleFiler will now try to help you open a library or import the data
in another way.

Capture scripts can now import tags and notes.

Text and Rich Text Files

It’s now possible to edit text, RTF, and RTFD files directly in the record viewer.
EagleFiler will automatically save any changes that you make and update the files’
checksums.

Creating new rich text files is much smoother. The keyboard shortcut is now
Command-N instead of Command-Control-N. If the File column is visible, Eagle-
Filer will bypass the sheet, select the new file in the records list, and bring the File
cell into edit mode so that you can set the filename and title. You can then tab into
the record viewer to begin typing the contents of the file.

You can drag records into the record viewer (or the notes text view) to create links
to them.

Searching

You can now search by tag. You can also add tag criteria when doing an Anywhere
or Notes search (e.g. tag:apple steve).

Now remembers the last-used search scope (globally and per-window).

“nttp://kula. jp/software/endo/
“nttp: //www.mozilla.com/en-US/firefox/
“http://www.happyapps . com/webnotehappy/
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Tags

You can now access the search syntax help page from the toolbar search field menu.

Added auto-completion when typing tag names.

Added tags field to the bottom of the browser window, so that you can edit the tags
of the selected record without having to open another window. You can quickly give
the tags field keyboard focus by pressing Command-Shift-T.

Tag sources now show all the e-mails with that tag (rather than just the files).
Tag sources now behave more like iTunes playlists and iPhoto albums. If you delete
a record from a tag source, EagleFiler unassigns the tag, but the record remains in
the library.

You can now arrange tags into a hierarchy in the source list, to organize them or to
hide the ones you don’t want to see at the moment.

Added New Tag menu command. If records are selected it changes to New Tag
From Selection and the selected records are assigned the new tag.

Browser Windows

You can now single-click to edit the Title, From, or File directly, instead of having
to open the Inspector window.

Added Convert For Editing command, which lets you convert Web archives to RTFD
files that can be edited.

If you hold down Option when double-clicking a Web archive (or a RTFD file con-
verted from a Web archive), EagleFiler opens the current version of the page rather
than the archive.

EagleFiler now shows custom icons for folders. You can set a custom icon using the
Finder’s Get Info window.

Added Show > Source List and Show > Record Viewer commands for people who
want to use the menu or keyboard intead of double-clicking the divider.

Added Actual Size and Zoom to Fit commands. The PDF viewer now remembers
its zoom state, so that it won’t keep resetting to Zoom to Fit if you’ve zoomed in.
Remembers the selected sources between launches.

Arrow-keying through the records list is faster now.

Libraries

Added Remember open libraries between launches preference and Startup Items
folder.

The Drop Pad now has commands for creating a new library, opening a library, and
opening recent libraries.
The Dock menu now shows recent libraries.

Other Enhancements

If you ask EagleFiler to import a URL and the URL can’t be saved as a Web archive
(e.g. because it’s an image or PDF), EagleFiler will download the file and import it
as-is, rather than reporting an error about not being able to save a Web archive.
Now imports MailTags** projects as tags.

“nttp://www.indev.ca/MailTags.html
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The Zoom In and Zoom Out commands now work with Web archives, where they
change the font size.

The Copy URL command is now called Copy Record Link.

Added Highlight command, which changes the background of the selected text to
yellow.

Added Outline and Styles. .. to the Format menu.

Dragging a library file onto the Drop Pad now opens the library rather than com-
plaining that the library can’t be imported.

Improved the way EagleFiler auto-generates file names when creating a file from
dragged text or a Web page’s title.

Now skips importing Apple Mail messages that are marked as deleted.

Capture scripts are now allowed to use the compiled script format, with the .scpt
extension.

Folders and mailboxes no longer have a title attribute that’s separate from the file
name.

When creating a new rich text file inside a sub-folder, it’s now revealed there instead
of in the Library source.

Indexing is now somewhat faster and uses less memory.
Double-clicking a folder now opens it in EagleFiler instead of in the Finder.

In the source list, single-clicking now enters edit mode and double-clicking now opens
the source.

Improved secondary sorting of records list.
Increased maximum width of the Kind column.
Added keyboard shortcuts for Select Source and Hide Others.

Rich text copied using Copy Record Link now includes the tite of the record, rather
than just the URL.

Now displays the proper background color for RTF documents.

Added Open Source URL, Copy Record Link, and Verify to the contextual menu.
The underscore and hyphen characters are now allowed in tag names.

You can now drag into the records list of a tag source to assign that tag.
Shortened toolbar button labels.

The menu commands for Show Inspector and Show Tags now toggle the visibility
of the windows rather than showing them.

The Software Update checker now works behind an HTTP proxy.

The Import Files menu command no longer allows you to import individual files
inside an Apple Mail mailbox, as this is usually an error.

Moved Open in External Viewer command to the Record menu.
Added keyboard shortcut for Open Source URL.

Reordered Record menu.

Reduced number of threads used on single-core Macs.

You can now delete tags from the source list.
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Bug Fixes

Periods in the names of folders are now treated as part of the name, rather than as
the beginning of a path extension.

Worked around OS bug that prevented phrase searching from working. Because of
this, EagleFiler will automatically rebuild the indexes of any opened libraries.

Fixed bug that could cause a crash when importing large folder hierarchies.

When importing a folder, EagleFiler will now ignore any invisible Find By Content
index files.

Fixed bug importing and moving files with very long names.
Fixed bug in .emlx exporter.

Fixed bug where EagleFiler couldn’t import a Web page if WebKit crashed while
trying to extract its text.

Fixed bug with using Capture command in Dock menu.

Fixed bug where EagleFiler didn’t let you capture if you launched it by opening a
library from the Finder and then switched to another application so that it finished
launching in the background.

The capture key is now ignored if EagleFiler is frontmost.

Fixed spelling and resizing of “Title” label in the New Rich Text File sheet.
Fixed crash that could occur when indexing.

Fixed bug where an indexing operation could stall indefinitely.

If a document or message can’t be indexed, EagleFiler is better at continuing on
and indexing the rest of the documents or messages.

Better logging of index problems.
Fixed bug where indexed searching didn’t work in tag sources.
Fixed bug where undo didn’t work after renaming in source list.

Fixed bug where the user could use drag and drop to change the page that the Web
view was displaying to one other than that of the selected Web archive.

Better display of messages with no text parts.

Fixed bug where the Recent smart folders didn’t show records that were inside
folders.

Fixed bug where Web archives couldn’t be displayed, depending on if you had certain
preferences set in Safari.

Fixed bug where the selection in the notes text view would be needlessly reset when
the library changed.

Fixed bug that could lead to error when undoing too far in the notes text view.

No longer allows you to give a file an empty name (before the extension), as this
confuses Cocoa.

Fixed bug where the Show Inspector command opened the inspector but didn’t give
it keyboard focus.

Worked around OS bug that could cause crash when using NetNewsWire Lite.

Fixed a few bugs that made it impossible to launch EagleFiler from a path containing
non-ASCII characters.
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e Fixed small memory leak when processing errors.

e Fixed bug where you couldn’t create a new folder with / in the name.
¢ Fixed bug where showed : instead of / when displaying file names.

e The file system encoding is no longer hard-coded to UTF-8.

e Improved thread-safety of record properties.

e When launching, no longer prints “CMSCreateDataProviderOrGetInfo : Invalid
colorspace type” message to console.

e Fixed bug where changes to a file’s name or title weren’t always propagated to the
index.

e Fixed bug where source URLs weren’t being cached properly.
e Fixed bug opening aliases of libraries.

e Fixed bug where you couldn’t create or open a library if its path contained non-
ASCII characters.

e Worked around bug in SOHO Notes (and other applications) that prevented drag-
and-drop importing of promised files from working.

e Fixed bug importing notes from MailTags®.
e Fixed bug where the drag image for a selected source used white text.

e Fixed bug where displaying an HTML e-mail message would take too long to time-
out.

e Fixed bug in reporting HTML rendering errors.
e Fixed internal error when closing a library right after opening it.

e Improved error recovery when an untrusted server certificate is encountered while
creating a Web archive.

1.0.2—October 14, 2006
e Fixed bug capturing from Apple Mail.
1.0.1—October 14, 2006

e Fixed problem where EagleFiler would sometimes crash at launch if an input manager
or haxie was installed.

e Worked around OS bug that caused jitter in the software update progress bar.

e The software update installer no longer says it failed if it succeeded.
1.0—October 13, 2006

e First public release.

Phttp://www.indev.ca/MailTags.html
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